delivering connected communities

\ Business Analytics Tips & Hints

‘ New World EPR: Business Analytics — Financial Management

PROJECT TRANSACTION DETAIL

OBJECTIVES

Understand the different Report Layout options and when to use them
Changing the Report Layout globally as well as on individual fields
Adding & removing subtotals globally and to individual fields

How to display blank row labels

Using the Collapse feature to quickly summarize a detail report

CREATING THE REPORT

1. Choose the Project Accounting measure group at the top of the PivotTable Field list

2.

PivotTable Fields /‘ x

Show fields: | Project Accounting |

Select the Journal Amount value from the field listing

4 T Project Accounting [«
[ Adopted Budget Amount

[ Budget Amendment
] Encumbrance Amount
Journal Amount

[ Reclassification Amoun

Drag fields between areas below:

T Filters - Col

= Rows

Journal Amount .
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3. Scroll down to the GL Account section and drag the Account Type field to Filters

4 D GL Account

Account Type
b [] Function
[] GL Account

3 Account Classificatio

Drag fields between areasgfelow:

Y Filters Il Columns

Account Type

P [] Account Classification ]

4. Filter the Account Type field to only show Expenses
a. Click the =/ button next to Account Type
Click the + sign next to All to display the list of Account Types

b
c. Select Expenses
d. Click OK

A A | 8 | e |
1 |AccountType All |

Search Acco

(- Fund Equity
&) Liability

- PY Fund Equity Adjustment
i Revenue

Os

Itiple ltems

ok | cancel
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5. Back in the field list, move the GL Account field to the Rows section

VL] ALLUUINL Classiieauun
Account Type

b [] Function
GL Account

O

L]

Drag fields between areas b

Y Filters olumns

" Account Type

= Rows Z Values

GL Account b Journal Amount v

6. Scroll down to the GL Date Section, expand the Calendar Date folder and move the Day field to

the Rows section (Below GL Account)

VL FISCal WeeKs

4 = Calendar Date
Day,

[]

L]

Y Filters I Columns
Account Type

Z Values

| Journal Amount v
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7. Scroll down to the Journal section and move Journal Number to the Rows section (Below Day)

P [ Kolling Uates
4[] Journal
Journal Number

[] Journal Refere
1 lanenal Tune

Drag fields between areas bel

Y Filters Columns
Account Type

= Rows es

GL Account urnal Amount
Day

Journal Number

8. Dragthe Process Status field to the Filters section

4[] Journal
Journal Number
[] Journal Reference
[ Journal Type
Process Status

Drag fields between areas bel

Y Filters Il Columns

" Account Type

Process Status .

Il

Rows % Values

GL Account v Journal Amount

Day v

JC I

P LELY P S
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delivering connec‘red communities

Filter the Process Status to only show Posted transactions
a. Click the ! button next to Process Status

b. Click the + sign next to All to display the list of Statuses
c. Select Posted then
d

Click OK

A A | B |
1 |Account Type Expenses 1|
2 |Process Status All ad|
3 [search Pm:essw
4 |Row Labels % o Al = |
5 | =100-41-02-53 99 - Op Exp Miscellaneou - None |
6 | =05/02/2014 @ m<—o

7 2014-00002439 - Removec

: =/100-42-15-56 00 - Cont Serv Profession B thpasted

9 | =04/30/2014
10| 2014-00002421
11| =05/28/2014 4
12| 2014-00002645
13| =06/25/2014 [ Select Multiple item:
14 2014-00002844
15 | =100-42-95-58 00 - Cap Out Capital Proje ECancell |
16| =01/01/1900 —

. Add L1-Project Code and Description as a row label

a. Scroll down near the bottom of the list to the Project Section

b. Expand the Characteristics folder

c. Dragthe L1-Project Code and Description field to the top of the Rows section (Above GL
Account)

4 Characteristics
[] Code1

O Code2

[] Code3

[ L1 - Project Code

L1 - Project Code And Description

C111 Nemin-s s J,

[»]

Drag fields between areas belc!

Y Filters

Account Type
Process Status

= Rows Z Values
L1 - Project Code ... ¥ || || Journal Amount v
GL Account > |[+]

. tyler
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Add the L1-Department field as a Filter

a. Scroll down a little further

b. Expand the Level 1 Details folder

c. Expand the Classification sub folder

d. Dragthe L1-Department field to Filters

L Levels
[] Level3

4 v Level 1 Details
[ L1 - Active Status

[ L1 - Exclude Balance Sheet

b Budget Info
4 Classification
[ L1 - Category
L1 - Department -

Drag fields between areas below:

Y Filters

Account Type
Process Status

L1 - Department

Filter the L1-Department field to only show 55 Public Works

a. Click the [/ button next to L1-Department

b. Click the + sign next to All to display the list of Statuses
c. Select 55 Public Works then

d. Click OK

|Account Type Expenses T
| Process Status M_{f
L1 - Department ) All { v |

S|

[search L1 - Department pEI
Row Labels = Al i o
= AMR Automated Meter Reading &

= 300-56-95-58 00 - Cap Out Capital ije 40 General Government

201/01/1900 i b ]
&] 50 Law Enforceme 3
2009-00001332 [E38 55 Public Works

2009-00001628 [- 56 Water Sewer Enterprise
2009-00002274 [#)- 57 Electric Enterprise
2009-00002616 [+ 60 Parks & Recreational Services
=310-57-95-58 00 - Cap Out Capital Proje € %
=101/01/1900 [ Select Multiple items
2009-00001332 y
2003-00002616 |__Cancel
= AS All-Star Park Pavilion Bond Project oo
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delivering connec‘red communities

USING THE GLOBAL REPORT LAYOUT AND SUBTOTAL SETTINGS

13. The report is currently in Compact Form, which combines all the row labels (Project, GL Account,
Date & Journal #) into a single column. It’s not the cleanest way to display the information for
this type of report.

y A Il B L [l
1 Account Type Expenses |7
2 memss Status Posted T
3 JLI - Department 55 Public Works T
4 |

5 ]Row Labels | * Journal Amount

6 | =/CAT Caterpillar Connector Road 1,328.00
7 =/661-58 01 - Cap Out Construction 1,328.00
8 =01/01/1900 1,328.00
9 2010-00001814 1,328.00
10_.} =/FRT TIP U-3605 - E FRONT ST 2,035,218.94
11| =/100-55-55-58 12 - Cap Out Street Repair and Improvements 1,986,193.64
121 =09/24/2013 127,947.30
13| 2014-00000703 127,947.30
14| =10/30/2013 6,979.87
15 | 2014-00000998 6,979.87
16|  =11/05/2013 241,156.46

14. Change the layout to the Tabular format
a. Atthe top of the excel file, under Pivot Table Tools
b. Click on the Design tab
c. Click the Report Layout button then Show in Tabular Form
d

This moves each field into their own columns

H ©- - 1

File Home Insert Draw Page Layout Formulas Data Review View

E [ g 3 aders [] Banded Rows =E===F

Subtotals Grand  FREpOrt] Blank oM Headers [ Banded Columns
~  Totals~ |[Layout=> Rows~

Analyze

Layol yle Options PivotTable St
2 |Process Statu B Shove b Lomprct Toms posted B
_|L1. - Departme 55 Public Works |-T|

B Show in Outline Form

3 -

4 -l

5 Row Labels v Joumal Amount

6 | =CAT Caterp D Show in Tabular Form 4 1,328.001
7 | =661-5801 1,328. 00
) =01/01/1 1,328.00
9

E Repeat All ltem Labels
2010- 1,328.00

10 SFRT TIPU-3 |- 2,035,218.94
11| ©100-55-55 D Do Not Repeat Item Labels 0o aments 1,986,193.64
..
e tyler
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delivering connected communities

15. The report also includes subtotals for the various row labels (Project, GL Account & Date). In this
case it doesn’t make sense to have the extra subtotals on the GL Accounts and Dates.

4 A | B e | D . E

1 |Account Type Expenses i

2 |Process Status Posted -

3 L1-Department 55 Public Works |-T

4 =

5 L1- Project Code And Description ~ GL Account v Day  ~ Journal Number - Journal Amoun
6 = CAT Caterpillar Connector Road =/661-58 01 - Cap O =01/01/1 2010-00001814 1,328.0
7 | 01/01/1900 Tota| <« 1,328.0
8 661-58 01 - Cap Out Construction Total s 1,328.0
9 |CAT Caterpillar Connector Road Total < f—— 1,328.0
10 | = FRT TIP U-3605 - E FRONT ST =1100-55-55-58 12 - =09/24/2 2014-00000703 127,947.3
11| 09/24/2013 Total 127,947.3
12 =110/30/2:2014-00000998 6,979.8

16. To turn off the Subtotals
a. Go tothe Design tab

b. Click the Subtotals button then Do Not Show Subtotals

H S

File

a -

Home Insert Draw Page Layout

Row Headers

Subtotals Gran Blank Column Headers
- Totals ~ Layout ~ Rows ~

le Style Options
‘ [I Do Not Show Subtotals

I Show all Subtotals at Bottom of Group

| Show all Subtotals at Top of Group

| —Y Include Filtered Items in Totals

Formulas Data

[[] Banded Rows

[[] Banded Columns

PivotTable Styles

Posted T
55 Public Works -T|
+ GL Account v Day  ~ Journal Number ~ Joun

-/661-58 01 - Cap O =01/01/1 2010-00001814
01/01/1900 Total
661-58 01 - Cap Out Construction Total

10| SFRT TIP U-3605 - E FRONT ST

=100-55-55-58 12 - = 09/24/2 2014-00000703

1] 09/24/2013 Total
(J
. tyler
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17. The extra subtotal lines should now be gone

y A | B | ¢ D l E
1 |Account Type Expenses ﬁ

2 |Process Status Posted [x]

3 |L1- Department 55 Public Works | Y|

4_

5 |L1- Project Code And Description ~/GLAccount |~ Day - Journal Number - Journal Amount
6 | ©ICAT Caterpillar Connector Road | ©661-5801- Cap O = 01/01/1 2010-00001814 1,328.00
7 | ZFRT TIP U-3605 - E FRONT ST =100-55-55-58 12 - = 09/24/2 2014-00000703 127,947.30
8 | =10/30/2 2014-00000998 6,979.87
9 | =11/05/2 2014-00001037 241,156.46
10| = 01/16/2 2014-00001609 270,227.96
1| =102/11/2:2014-00001771 209,194.61
12| =103/19/2 2014-00002079 22,449.51
13| =04/08/2 2014-00002243 24,692.85
14 = 05/06/2 2014-00002471 85,959.96

-
n

Lacioa /s ania noooscocs Pl A, T LW L

18.

apply these settings to individual fields

19.

while leaving the remining fields in Tabular Form

a.
b. Click Field Settings

Right click on any projects in the first column

The Report Layout and Subtotal settings shown above apply to the entire report. We can also

This report for example would look better with the Project Description in the Compact format

A
_|Account Type
_|Process Status
L1 - Department

W N -

sju Project Code And Descrlpth
6 | =CAT Caterpillar Connector Rc

88 Group..
@8 Ungroup..
Move

Remoyve “L1 - Project Code And Description”

I

ks ¥

‘* Day I' Journal Nui
CapO -101/01/1 2010-00001

7 | = FRT TIP U-3605 - E FRONT ST Show Properties in Report » 812- =09/24/2 2014-00000
8#- Show Properties in Tooltips » =10/30/2 2014-00000
9 | s 511/05/2 2014-00001
10| sasaisaisie s =01/16/2 2014-00001
1| (@ Field Settings.. «(mmm———— =02/11/2 2014-00001
12| PivotTable Options... =03/19/2 2014-00002
13 Hide Field Lit =04/08/2 2014-00002
14 y = 05/06/2. 2014-00002
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delivering connected communities

Select the Layout & Print tab
Select the Show item labels in outline form option

Check the box to Display labels from the next field in the same column (compact form)
Click OK

S o a0

F'(—I;i‘}rﬂtmg: ? b4

Source Name: L1 - Project Code And Description
Custom Name: \-L'l - Project Code And Description
Subtotals & Fi Layout & Print

w item labels in outline form
g play labels from the next field in the same column (compact form)

(O Show item labels in tab

[[] Repeat item labels
[J insert blank line after each item label
Show items with no data

Print
[:l Insert page break after each item

. The Project and GL Account are now located in the same column while the Date and Journal
number are in separate columns

A A ‘ B | C | D |
1 |Account Type Expenses |.x|

2 |Process Status Posted [

3 |L1- Department I 55 Public Works -
47

5 Row Labels '~ Day Journal Number  Journal Amount
6 | = CAT Caterpillar Connector Road

7 | =661-58 01 - Cap Out Construction =101/01/1900 2010-00001814 1,328.00
8 | =FRT TIP U-3605 - E FRONT ST
9 | =/100-55-55-58 12 - Cap Out Street Repair and Improvements  =09/24/2013 2014-00000703 127,947.30
10 =10/30/2013 2014-00000998 6,979.87
11 =11/05/2013 2014-00001037 241,156.46
12| -01/16/2014 2014-00001609 270,227.96
13| =02/11/2014 2014-00001771 209,194.61
14 | -103/19/2014 2014-00002079 22,443.51
15 -104/08/2014 2014-00002243 24,692.85
16 =05/06/2014 2014-00002471 85,959.96
17 -06/03/2014 2014-00002686 65,893.83

o.% I
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21. We can also turn on subtotals for just the Project while leaving them off for the GL Accounts and

11

the Date

Right click on any projects in the first column

b. Click Field Settings

4 B £  Quick Explore | c |
1 |Account Type = Ei
=7 8 Group..
2 |Process Status g EJ
3 |L1- Department @8 Ungroup.. HES|
4_ Move »
5 |Row Labels < Remoye “L1 - Project Code And Description” Journal Number  Journ
6 | = CAT Caterpillar Connector Roai
7 =/661-58 01 - Cap Out Construcl 2010-00001814
8 = FRT TIP U-3605 - E FRONT ST Show Propemes in RCQOI‘t »
9 | =100-55-55-58 12 - Cap Out Stru Show Properties in Tooltips 4 2014-00000703
19_ Additional Actions » 2014-00000998
11 2014-00001037
LA [@ Field Settings... 4—
1_2 . - 2014-00001609

Select Automatic under the Subtotals section

Field Settings

Source Name: L1 - Project Code And Description

Custom Name: !Li - Project Code And Description

Subtotals & Filters  Layout & Print

Subtotals

® Automatich
(O None
Custom
Select one or more functions:

Sum A
Count

Average

Max

Min

Product g
Filter

] Include new items in manual filter

| I Cancel

o.0% I
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Click on the Layout & Print tab

delivering connected communities

Uncheck Display subtotals at the top of each group

Click OK

Field Setting

Source Name: L1 - Project Code And Description

Custom Name: L1 - Project Code And Description ; |
Subtotals & Filters  Layout & Print 4
Layout
(® Show item labels in outline form

Display labels from the next field in the same column (compact form)
a#olay subtotals at the top of each group

[[] Repeat item labels
[ Insert blank line after each item label
Show items with no data

- 2

[ insert page break after each item

o] [ conce

22. You should now see a subtotal for each Project

4 A 1 B | C ; D ,
1 |Account Type Expenses Ed]

2 |Process Status Posted Ed|

3 |L1- Department 55 Public Works |-T|

4

5 Row Labels B Day Journal Number  Journal Amount
6

12

10_ =/100-55-55-58 12 - Cap Out Street Repair and Improvements -09/24/2013 2014-00000703 127,947.30
1 ‘I__ =110/30/2013 2014-00000998 6,979.87
12| -11/05/2013 2014-00001037 241,156.46
@
. tyler
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DISPLAY MISSING ROW LABELS

delivering connected communities

23. By default, the report hides row labels if it is repeat of the same value as the previous line. - For
example, the GL Account and dates are not displaying on some of the rows where it’s a repeat of
the prior row

5 |Row Labels |~ |pay Journal Number  Journal Amount
6 | = CAT Caterpillar Connector Road

7 | =/661-58 01 - Cap Out Construction =01/01/1900 2010-00001814 1,328.00
& |CAT Caterpillar Connector Road Total 1,328.00
9 | =FRT TIP U-3605 - E FRONT ST

10 | =100-55-55-58 12 - Cap Out Street Repair and Improvements  =/09/24/2013 2014-00000703 127,947.30
1 =10/30/2013 2014-00000998 6,979.87
12 =11/05/2013 2014-00001037 241,156.46
13 =01/16/2014 2014-00001609 270,227.96
14 =02/11/2014 2014-00001771 209,194.61
15 =03/19/2014 2014-00002079 22,449.51
16 = 04f08/2014 2014-00002243 24,692.85
l?:l =05/06/2014 2014-00002471 85,959.96
18 =106/03/2014 2014-00002686 65,893.83
19 - 06 4 2014-00002924 154,980.66
20 2014-000025438 98,545.71
21 2014-00002956 257,230.49
22 2014-00002974 (3,648.11)
23 -109/17/2014 2015-00000648 24,702.75
24 =11/12/2014 2015-00001139 164,020.95
25 “nafiglnas 201500002275 2 825 31

Make sure you have the Design tab selected at the top of the excel file

24. On this report we want to see all repeating labels
a.
b. Click on Report Layout
c. Select Repeat All Item Labels

Fi

le Home Insert Draw Page Layout

caders

Formulas Data

[[] Banded Rows

Review el

Analyze

B [

Subtotals Grand Report n Headers [ ] Banded Columns rE,_ e
v Totals - Layout~ Rcms bt
Layol yle Options PivotTable Styles
:| Show in Compact Form

A8 > illar Connector Road Total

4 [ Show in Outline Form 8 c E
4]

5 |Row Labels j Show in Tabular Form Journal Number  Journal Amount

6 | ZCAT Caterp

7 | ~661-58 01 . Repeat All Item Labels ﬂ -01/01/1900 2010-00001814 1,328.00

8 |CAT Caterpill 1,328.00

9 J SFRT TIPU-3 | J Do Not Repeat Item Labels

10 ' =100-55-55 aprovements = 09/24/2013 2014-00000703 127,947.30

... ..
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25. We now see all repeating labels have been filled in
5 Row Labels Day Journal Number  Journal Amount |
6 | ~/CAT Caterpillar Connector Road |
7 =/661-58 01 - Cap Out Construction -101/01/1900 2010-00001814 1,328.00
8 CAT Caterpillar Connector Road Total 1,328.00
9 | =/FRT TIP U-3605 - E FRONT ST |
10 =100-55-55-58 12 - Cap Out Street Repa irand Improvements  =09/24/2013 2014-00000703 127,947.30
11 100-55-55-58 12 - Cap Out Street Repair and Improvementsf§l =10/30/2013 2014-00000998 6,979.87
12 | 100-55-55-58 12 - Cap Out Street Repair and Improvementsf§l =/ 11/05/2013 2014-00001037 241,156.46
13 100-55-55-58 12 - Cap Out Street Repair and Improvementsf§l -01/16/2014 2014-00001609 270,227.96
14 | 100-55-55-58 12 - Cap Out Street Repair and Improvementsf§l = 02/11/2014 2014-00001771 209,194.61
15 100-55-55-58 12 - Cap Out Street Repair and Improvementsf§l = 03/19/2014 2014-00002073 22,449.51
16 100-55-55-58 12 - Cap Out Street Repair and Improvementsj§| = 04/08/2014 2014-00002243 24,692.85
17 100-55-55-58 12 - Cap Out Street Repair and Improvementsf§l = 05/06/2014 2014-00002471 85,959.96
18 100-55-55-58 12 - Cap Out Street Repair and Improvements 2014-00002686 65,893.83
19 100-55-55-58 12 - Cap Out Street Repair and Improvements 2014-00002924 154,980.66
20 | 100-55-55-58 12 - Cap Out Street Repair and Improvements 2014-000029438 98,545.71
21 | 100-55-55-58 12 - Cap Out Street Repair and Improvements 2014-00002956 257,230.49
22| 100-55-55-58 12 - Cap Out Street Repair and Improvements 2014-00002974 (3,648.11)
23 | 100-55-55-58 12 - Cap Out Street Repair and Improvements 2015-00000648 24,702.75
24 100-55-55-58 12 - Cap Out Street Repair and Improvementsfl =/11/12/2014 2015-00001139 164,020.95

USING THE EXPAND/COLLAPSE OPTIONS

26. Collapse data on a single project
a. Click on the minus sign next to the first project (CAT Caterpillar Connector Road)
b. This is a quick to summarize the data to the overall project report

5 Row Labels v Day Journal Number
6 | :!Wnedor Road
7 | ©661-58 01 - Cap Out Construction =01/01/1900 2010-00001814
8 CAT Caterpillar Connector Road Total
9 _ ='FRT TIP U-3605 - E FRONT ST
o®
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27.

28.

15

delivering connecfed communities

Collapse the data on all projects

a. Right Click on any project description
b. Select Expand/Collapse

c. Click Collapse Entire Field

E® Copy

Journal Number

Jour

‘Row Labels @ Format Cells... __Emv

+ CAT Cate
| PR P Refresh I

=IFRT TIP | |
=1100-55 o 2a/2013
100-55 =110/30/2013
100-55 =11/05/2013
B FETAF LY ]

Expand

Sort »

Filter »

ants
ants

v Subtotal "L1 pnts
antc

Expand/Collapse 8 |

00-55  Drill Down/Drill Uy 3
100-55 2 Quick Explore +=

100-55 e_—_'.;

- Project Code And Description”

100-55

Collapse
Expand Entire Field
Collapse Entire Field

B © 5l:i31‘°1°°.|“'l°'i"'1‘“1k

15|
Led

@8 Group..
88 Ungroup...

17| 100-55 °

2014-00000703
2014-00000998

2014-00001037
2N1A.00NN1ANQ

100-55
The entire report is now summarized to the project level

A | B ' C

D

Row Labels |~] Day

Journal Number

Journal Amount

| #/CAT Caterpillar Connector Road
+/FRT TIP U-3605 - E FRONT ST

1,328.00
2,035,218.94

+S81 Street Improvements Bond Project - Section 1

955,819.55

482 Street Improvements Bond Project - Section 2

4,081,312.74

10 #VM Vehicle Maintenance

6,387.20

11 Grand Total

7,080,066.43

Empowering people who serve the public®
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delivering connecfed communities

PURCHASE ORDER COUNT BY DEPARTMENT

OBJECTIVES

Filtering on individual rows and column labels

Understand the different date options

Using formulas outside of the pivot table

Creating and formatting a graph from the business analytics data

CREATING THE REPORT

1. Choose the Purchase Request measure group at the top of the PivotTable Field list
PivotTable Fields / v X
Show fields: | Purchase Request v| | &~

2. Select the Purchase Request Count value from the field listing

4 X Purchase Request [a]
[] Discounted Amount

[C] Encumbered Amount
[[] Expensed Amount
Purchase Request Coun
[] Quantity

[

Drag fields between areas below:

Y Filters Il Columns

2 Valu

i
g
&

Purchase Request Count ¥

16 Empowering people who serve the public®
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delivering connected communities

FILTERING ON A ROW LABEL

section.

J NI N

3. Scroll down to the Organization Structure section and move the Org Structure field to the Rows

4 [] Organization Structure
b [¥] Org Structur

b [z More Fields

4 [5] PO Entered Date
b [J PO Entered Date,Calendar

b [] PO Entered Date.Calendar Wgks

Drag fields between areas below;

T Filters 1l Columns
= Rows % Values
Org Structure » Purchase Request Count ~

4. Filter the department list to show the top 5 departments
a. Click the =/ button in the cell that says Row Labels

b. Go to Value Filters and select Top 10

A A
1 [Row Labels
2  Select field:
3 OrgGroup 1
4. 4| sotAtoz
5
6_ Zl sotZtoa
7 More Sort Options...
8%
9 Label Filters
10 )
= Value Filters
12 Search Org Group 1 Equals...
13 [ (Select All) Does Not Equal...
14 (#-[¥] 40 - General Government
15— 41 - Finance Greater Than...

=1 [#-[¥] 42 - Community Development Sery Greater Than Or Equal To...
16 [#-[#] 47 - Information Services 5
17 [+)-[¥] 48 - Public Information Less Than...
18 [+] 49 - Customer Service Less Than Or Equal To...
15 (#1450 - Law Enforcement

= [#-[¥]52 - Fire Protection Between...
= 5= Not Between...
21

> 0 Top 10...
22 oK | Cancel i

e

Empowering people who serve the public®




delivering connecfed communities

c. Change the 10 to 5 in the 2™ field and click OK

Top 10 Filter (Org Group 1) ? X
Show
Top jS— by ‘Purchase Request Count
ok | cancel

5. Add the Process Status field to the Filters
a. Scroll down to the Purchase Order section
b. Expand the Characteristics folder
c. Add Process Status to the Filters

[]

4 [5] Purchase Order
[[] Purchase Order

4 v Characteristics
[] Delivery Method

[] Entered By

[C] PO Form Type
(] PO Type

[ Prior Year
Process Status

[]

Y Filters

Process Status

Il Columns

. tyler
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6. Filter the Process Status field to only show Completed POs
a. Click the ! button next to Process Status
b. Click the + sign next to All to display the list of Statuses
c. Select Complete then click OK

y A | 8 I
1 |Process status [an ral
2_ |Search Process Status
3 {Row = Al
4 |®41-Finance Cancelled
5 |#50- Law Enforce B
6 | #55 - Public Work
=1
7 | #¥56 - Water Sewe
8 |57 - Electric Entt
9 Grand Total
10|
1
12 O se tiple ltems
13
12l ok | | Ccancel
15

WORKING WITH THE DIFFERENT DATE OPTIONS

7. Scroll up to the PO GL Date section and first add the PO GL Date.Calendar field to the Columns
section

4 [F] PO GL Date
4 PO GL Date.Calendar

b [] PO GL Date.Calend
» [] PO GL Date.Fiscal
» [] PO GL Date.Fiscal Weeks
b B Calendar Date

b Fiscal Date
b Formatted
b

Rolling Dates

N " ~ o
Drag fields between areas below:

Y Filters olumns

Process Status hd O GL Date.Calendar ~
@
o tyler
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Filter the Date to show Calendar 2016 & 2017

a. Click the =/ button in the cell that says Column Labels
b. Uncheck the box next to Select All

c. Select Calendar 2016 and Calendar 2017

d

Click OK
4 A B C
1 |Process Status Complete X
2
3 Purchase Request Count Column Labels ~
4 RowlLi Select field: + Calendar 2012
5 |#a1- vear ~| 342
6 |®50-/ 8| <onatoz 8
7 |®55-] . mn
i z A
8 |@ss- il senZtwe 297
9 1 #57- More Sort Options. 92
10 Gnnd % 1,197
n Date Filters >
‘Z- Value Filters »
13
14 Sgarch Year 403
15 W (Select AN) -
16 &[] Calendar 1500
17 @[] Catendar 2010
5 @ |£.l Calendar 2011
18 @ (] Calendar 2012
19| memm 2013
20| . 4
21
2 =
! B ¥
2| Y-
2] Cancel
25|

Expanded the year to show additional detail
a. Click the + sign in the Calendar 2017 cell

4 A ‘ B , c | D

1 Process Status Complete x|

2_..

3 Purchase Request Count Column Labels -7

4 Row Labels .Y +Calendar2016 +'Calendar 2017 Grand Total
5 |#41-Finance 282 211 493
6 | #50- Law Enforcement 165 114 279
7 |#55 - Public Works 253 212 465
8 |#56 - Water Sewer Enterprise 391 300 691
9 |#57 - Electric Enterprise 230 315 545
10 Grand Total 1,321 1,152 2,473

. tyler
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b. This will expand the column to show the counts broken down by quarter
Next, click the + sign next to one of the quarters to see it broken down by month
4| A | B | C | D , £ [ F .| G
1 |Process Status Complete |7l
2
3 |Purchase Request Count Column Labels |-¥|
4 +Calendar2016 -/Calendar 2017 Grand Total
5 Row Labels x| q!.l(.‘luarter 1,2017 +Quarter 2, 2017 + Quarter 3, 2017 + Quarter 4, 2017
6 | ®41- Finance 282 31 22 86 72 493
7 | ®50- Law Enforcement 165 12 33 44 25 279
8 |#55- Public Works 253 49 29 122 12 465
9 | #56- Water Sewer Enterprise 391 118 77 73 32 691
10 | #57 - Electric Enterprise 230 133 67 38 27 545
11 | Grand Total 1,321 343 228 a13 168 2,473
d. You can then expand any of the months to show the detail by date
y A | B | C | D , E F
1 |Process Status Complete [-‘f_j
2
3 |Purchase Request Count Column Labels -7/
4 | +Calendar 2016 - Calendar 2017
5 | =/Quarter 1, 2017 + Quarter 2, 2017
6 Row Labels [,-[ —’ +January 2017 + February 2017 + March 2017
7 | ®41-Finance 282 19 5 22
8 |#50- Law Enforcement 165 3 5 4 33
9 | #55- Public Works 253 18 20 11 29
10 | #56 - Water Sewer Enterprise 391 39 34 45 T
e. Click the —sign next to Calendar 2017 to once again summarize the detail by year
P A | B | C | D | E F )
1 |Process Status Complete ¥,
2 —
3 | Purchase Request Count Column Labels .Y/
4 | + Calendar - Calendar 2017
5 | -/Quarter 1, 2017
6 | =January 2017
7 Row Labels E 01/04/2017 01/05/2017 01/06/2017 01/07/2017
8 |¥41-Finance 282
9 | #50- Law Enforcement 165
10 | #55 - Public Works 253 4 4
11 | 56 - Water Sewer Enterprise 391 21 8 1
@
o tyler
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10. The other date fields that are not grouped in subfolder work similarly to allow you to drill down

into additional detail

b [C] PO GL Date.Fiscal
b [J PO GL Date.Fiscal Weeks
b Calendar Date

b Fiscal Date
b Formatted
P Rolling Dates

b H PO GL Date.Calendar g
b [[] PO GL Date.Calendar Weeks

11. Next, remove the PO GL Date.Calender Column label from the report (either uncheck the box or
drag the field from the columns section and drop outside of the field listing)

4 [5] PO GL Date
PO GL Date.Calendar

» [J PO GL Date.Fiscal

b Calendar Date
b Fiscal Date

b Formatted

P Rolling Dates

Process Status

b [J PO GL Date.Calendar Weeks

b [] PO GL Date.Fiscal Weeks

Drag fields between areas below:

(2]
Y

[]

Il Columns
PO GL Date.Calendar v

Empowering people who serve the public®

tyler

technologies



72018 D ININ

delivering connected communities

12. In the field list, expand the Calendar Date field and add the PO GL Date.Year field to the Columns
section

4 = Calendar Date [«]
[J PO GL Date.Day
[ PO GL Date.Day Of Menth
[J PO GL Date.Day Of Week
[[] PO GL Date.Menth
[J PO GL Date.Month Of Year ‘J
[J PO GL Date.Quarter
[] PO GL Date.Quarter of Year
[] PO GL Date.Week
[] PO GL Date.Week of Year
Year -

Drag fields between areas below:

T Filters 1 clumns

Process Status v Year v

13. Follow the same process as Step 8 but only filter it to show Calendar 2017

4| A B | C |
| 1 |Process Status Complete Ll
2
3 |Purchase Request Count lcolumn Labejgr - |
4 [Rowli 7| SortAtoZ ‘Calendar 2012
5 |®41- 12| sonZtoA 342
| B 950~ More Sort Options... 83
7 |®55- 277
= h ear Filter Frarr e
| 8 |®56-] > ' 397
| 9 |®57- Date Filters » 92
| 10 Gra; Value Filters i 1,197
n
l 12| Search Year pE]
{13 (Select All A
7 [ [] Calendar 1900
144 &[] Calendar 2010
| 15 #[] Calendar 2011
16 #-[J Calendar 2012
7 (-] Calendar 2013
17
I (&[] Calendar 2014
Bl @[] Calendar 2015
19 [] Calendar 2016
| 20 ? .
21 s
22| 4 p ox | | conce
23
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14. You'll notice the + sign doesn’t exist for this field. The date fields within the folders do not have

the built-in drilldown detail.

y A , B | <

1 |Process Status Complete ES

2_

3 Purchase Request Count

4 Row Labels

5 |#41-Finance
A + 80 1w Enfarcamnant 114 114

15. Next go up about 10 lines in the filed list and add the PO GL Date.Day of Week field below the

Year in the Columns section

4 Lalendar Date
[] PO GL Date.Day

Day Of Week
[] PO GL Date.Mont

[] PO GL Date.Quarter

[] PO GL Date.Week
[] PO GL Date.Week of Year
Year

Drag fields between areas below:

[] PO GL Date.Day Of Month

[] PO GL Date.Month Of Year

[[] PO GL Date.Quarter of Year

Y Filters Il Columns
Process Status v Year v El
Day Of Week il |

B
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16. Turn off the Subtotals

a. Click on the Design tab at the top of the excel file
b. Select Subtotals

c. click on Do Not Show Subtotals

Home Insert Draw

Formulas

i Row Headers [C] Banded Rows

Subtotals Grand Blank Column Headers [] Banded Columns

¥ Totals~ Layout~ Rows~
Table S ns PivotTable Styl
D Do Not Show Subtotals

bels .7 J
B Show all Subtotals at Bottom of Group -2017 Calen

- | Monday Tuesday Wednesday Thursday Friday Saturday
, E Show all Subtotals at Top of Group 26 a4 42 57 3
13 Sl ZBI 21 41 3

Page Layout Data Review View Analyze

USING YOUR OWN FORMULAS TO REFERENCE PIVOT TABLE DATA

17. Click in the cell to the right of the last column in your table next to the first grand total number

F 6 | H | 1+ | 3 | k |
Grand Total
ursday Friday Saturday __ /
39 o 3 211
21 41 3 114
54 62 11 212

18. Enter a formula to combine the counts for Monday & Tuesday. You'll notice that the formula
contains a lot of extra information but the result is correct

F G H 1 J K L M N 0 P
Grand Total
hursday Friday Saturday

39 57 3 211|=GEFPIVOTDATA|“[Measures].[Purchase Request Count]",5A%3,"[Organization

21 41 3 114 Structure].[Org Structure]”,”[Organization Structure).[Org Structure].[Org Group 1).&[41 -

54 62 11 212 Finance]","[PO GL Date].[Year]","[PO GL Date].[Year].&[2017]","[PO GL Date].[Day Of

53 76 300 Week]","[PO GL Date].[Day Of Week].&[2]")+GETPIVOTDATA("[Measures].[Purchase

69 51 3 315 Request Count]",SAS3,"[Organization Structure].[Org Structure]”,"[Organization

236 287 20 1,152 Structure].[Org Structure].[Org Group 1].&[41 - Finance]","[PO GL Date].[Year]","[PO GL

Date].[Year].&[2017]","[PO GL Date].[Day Of Week]","[PO GL Date].[Day Of Week].&[s]"||

o % I
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19. Copy the formula down to the rest of the table. The problem is the formula is still referencing the
cells in the first row.

Grand Total |

:sday Wednesday Thursday Friday Saturday |
44 42 39 57 3 211 70 |

8 28 21 a1 3 114 70 |

a8 20 54 62 1 212 70 |
28 100 53 76 300 70 |
32 127 69 51 3 315 70 |
160 317 236 287 20 1,152 |

20. For this to work, you need to first turn off the GetPivotData setting
a. Click back anywhere on the pivot table so the PivotTable Tools tab show up at the top
b. Go to the Analyze tab
c. Click on Options (all the way to the left)
d. And unselect the Generate GetPivotData option

H ©- $-

File Home Insert Draw Page Layout Formulas

PivotTable Name:  Active F, " < Group Selection —_— : B D [# Clear
ks S8 [ seled
Dril Refresh Change Data |
Ngs  Down - Source = 3 Mov

ve Field Data A
f« | Account Type

- L n E E [ =] 1 1 4 1

21. Go back to the cell where you originally entered the formula and enter it again using the same
method to combine Monday and Tuesday. It now looks like a normal excel formula.

| ¢ | o | € | F | 6| H | | [
1 |
17 Grand Total g
~_Monday Tuesday Wednesday Thursday Friday Saturday |
| 26! a4l a2 39 57 3 211|=C6+4D6 |

o % I
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22. Copy the formula down to the remining rows and you’ll see the values are now updated to show
the correct amounts

| c | D | E F | G | H | I | J L
Grand Total
Monday Tuesday Wednesday Thursday Friday Saturday
26 44 42 39 57 3 211 70,
13 8 28 21 a1 3 114 21
17 48 20 54 62 11 212 65
42 28 100 53 76 300 70
33 32 127 69 51 3 315 65
131 160 317 236 287 20 1,152

CREATING A PIVOT CHART

23. Click anywhere back on the pivot table
24. Select the Analyze tab and click the PivotChart button

Page Layout

Purchase Request \L‘ ¢

— Drll  Dell =
[ Field Settings oy Up

Active Field

PivotTable Name:  Active Field:

PivetTabled

E—a Options =
PrvotTable

3 Gr

I @ Clear~
Le .’_E [T} Select -
Refresh Change Data
s = Sources 4 MovePivotTable
Data Actions

[ Fields, Items, & Sets~ n
U5

Jfi OLAP Tools ~ -
= ivotChart
oF Rej v
ions

25. Select the Stacked Column (2”d option) chart under the Columns section and click OK

o o m

Stacked Column

& Ungroup

7] Group Fieid Slicer Timeln Lo

Group Filter

E7 fe 28

nsert Chart
All Charts

™ Recent
Templates
Column
Line

Pie

Bar

Area

XY (Scatter)

Map

Steck

Surface

Radar
Treemap
Sunburst
Histogram
Box & Whisker
Waterfall

Funnel

FIEEFOEXBEcEEMeRE

Comba

oK concel |

°
()

e %

% ¢
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26. Modify the Chart Elements
a. Click anywhere on the chart and click the large + sign in the top right corner
b. Check the box next to Data Labels to display the counts for each day directly on the graph

o ' .
f Processstatus + Y Chiart Elomments. 2
| Purchase Request Count [ ey A
350 [ | O s Titles
D Chart Tltle
00 ] Data Table
a - [ Error Bars
Year T Ay
250 f = Gndlines
V]
o w Calendar 2017 - Saturday Legend
m Calendar 2017 - Friday
) 155 m Calendar 2017 - Thursday C Drz
w Calendar 2017 - Wednesday -
100 m Calendar 2017 - Tuesday -
m Calendar 2017 - Monday
- mCalendar 2017 - Sunday
=
41 -Finance 50 - Law 55 - PublicWorks 56 - Water Sewer 57 - Electric o
Enforcement Enterprise Enterprise
Org Structure Y &
O O O =

27. Click the Paint Brush Icon and select any of the formation options to change the style of the
graph

,? Processtahs +Y = ferch |
Purchase Request Count Style | Color !f
(2] be

bl
| 5e
7% H ! Iy
DayOfweek -~ in|
m Calendar 2017 - Saturday .
= Calendar 2017 - Friday
= Calendar 2017 - Thursday per]

» Calendar 2017 - Wed!

= Calendar 2017 - Tuesd.

= Calendar 2017 - Monday
= Calendar 2017 - Sunday

. . I
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